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It’s here! Well … almost. The 64­
bit version of PCLinuxOS has hit
the testing phase. Texstar has
been extremely busy building a
fully functional 64­bit version,
along with a corresponding 64­
bit repository. To date, there are
over 7,000 applications in the
64­bit repository. Remember that
this is still considered to be in
testing, so it’s recommended that
you not use this as your every
day, go­to version of
PCLinuxOS.
In other news, Sproggy has
finished up not only the new
release of Phoenix,
PCLinuxOS’s Xfce version, but
he has also finished up a
“Phoenix Mini” version, re­
branded as Phinx. A Phinx is the
baby of the legendary Phoenix,
so it’s only fitting that the
trimmed down Xfce offering be
named after the Phoenix offspring. More than that,
Phinx offers native Xfce applications as defaults
whenever possible. The entire Phinx LiveCD weighs
in as a 410 MB download.
Also, melodie has released the latest, updated
version of the Openbox LiveCDs in two flavors: the
“full” version (a 638 MB downoad), and a new
version of the lighter Openbox Bonsai (a 263 MB
download). The updated Openbox LiveCDs come
with the latest Openbox release, Openbox 3.5. Also,
with this release, the default panels used in the
respective versions have been flip­flopped: the “full”

version uses lxpanel, while
Bonsai uses tint2.
Of course, all of the recent
releases use the latest Linux
kernel, 2.6.38.3.
Texstar has also been busy trying
to build a PCLinuxOS version of
Gnome 3. You can follow his
progress via his Twitter posts.
To be honest, I didn’t think we’d
get as much mileage out of the
Openbox series of magazine
articles as we have gotten. It just
seemed inconceivable to me,
when we started, that there would
be that much to write about for
such a lightweight environment.
Boy, was I ever wrong! Not only
do we have three more Openbox
articles in this month’s issue of
the magazine, but there will also
be three Openbox articles for the

October issue of the magazine as well, bringing the
number of Openbox articles to a total of twelve.
That’s three a month, for four months! All of you
LXDE users should also find the Openbox articles
interesting and relevant, too, since LXDE uses
Openbox as it’s window manager.
One thing that I’ve discovered that I like about
running Openbox is that is literally sips the power
from the battery of my test laptop that I have it
installed on (I installed the “full” version of Openbox).
It’s an older IBM Thinkpad T23, with a 1.13 GHz
Pentium III processor, 512 MB RAM, 8 MB video

RAM, with the DVD­RW drive removed and a
secondary battery pack inserted in its place. To
connect to the ‘net, I am using a PCMCIA DLink
WNA­1330 wireless 802.11g networking card. Even
with the wireless on, I’m finding the the battery time
in this older laptop lasts close to four hours!
Now mind you, this is not a laptop that was built at a
time when you could expect to get more than a
couple of hours running time using the battery. Even
with Xfce installed, I used to get only about three
hours of running time when using the battery
combination. So, with Openbox, I’ve further
extended the amount of time that I can run off of the
battery by 33%. So the reports of Openbox being a
power miser are definitely not over­exaggerated.
Plus, even as old as this laptop is, I find that
Openbox runs quite fast on it. There is hardly any
lag. I just have to be careful to not launch too many
memory intensive applications (such as Chromium
and Firefox) simultaneously, since the meager­by­
today’s­standards 512 MB of RAM gets filled up
soon. When that happens, the disk­based swap
partition gets utilized, bringing my system to a crawl.
Still, I’m finding the Openbox releases to be a very
good choice, especially for users wanting to get
more mileage from older equipment they may have
sitting around the house.
Well, that’s probably about enough from me for this
month. I hope you enjoy the continuing coverage of
the Openbox releases, along with all of the other
informative articles and columns we bring you each
month in the magazine. Until next month, I wish
each and every one of you unlimited prosperity,
serenity, tranquility, and peace.

Welcome From The Chief EditorWelcome From The Chief Editor

http://ftp.heanet.ie/pub/pclinuxos/live-cd/pclinuxos64-test01.iso
http://ftp.heanet.ie/pub/pclinuxos/live-cd/pclinuxos-phoenix-2011-07.iso
http://ftp.heanet.ie/pub/pclinuxos/live-cd/pclinuxos-phinx-2011.08.iso
http://tyruiop.eu/~melodie/Downloads/ISOS/PCLinuxOS_En_2011/pclinuxos-openbox-2011.08.iso
http://tyruiop.eu/~melodie/Downloads/ISOS/PCLinuxOS_En_2011/pclinuxos-openbox-bonsai-2011.08.iso
http://twitter.com/iluvpclinuxos
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by Meemaw

“Which Openbox Live CD should I use? What are
the differences?”
In this article we’ll explore the differences between
the full Openbox Live CD and the Openbox­Bonsai
mini Live CD. Just like the other ‘mini’ versions of
PCLinuxOS, Openbox­Bonsai is a smaller Live CD,
with only a few needed programs to get you started.
You can pick and choose what programs you want
and not have to use what someone else has chosen.
For this article, we will use the most recent official
releases, Openbox­Bonsai­2011.03 and Openbox­
2010.11.

Bonsai
Bonsai is the minimum version of Openbox. The ISO
is 266 MB, and contains just a bare minimum of
programs to get you started in the Openbox
experience. The rest you can pick and choose for

yourself, via Synaptic. Programs on the Live
CD/default installation include:
Midori and Firefox web browsers
flPhoto Photo Viewer
LibreOffice Manager
PCManFM File Manager
Geany (Text Editor)
File Roller (Archiver)
HTop system monitor
NetApplet
Sakura and XTerm Terminals
The current official version of Bonsai includes
lxpanel as the default panel. Rumor has it that in the
upcoming release of Bonsai, it will use tint2 as the
default panel.
You can see here the menu structure and the
choices that Bonsai offers in the ‘More Applications’
section.

Openbox Full
The full­size Live CD of Openbox is 685 MB and,
naturally, includes loads more programs.
In the Internet section, programs include:
Firefox and Midori web browsers
Sylpheed
Gajim and XChat
Deluge
Pino
Filezilla
Transmission
In the Graphics section you see:
Fotoxx
Gimp
Rapid Photo Downloader
flPhoto, GQView, GPicView
Screenie
XSane
The Office section contains:
OpenOffice Manager
Galculator
Gnumeric
Abiword
Sunbird and Osmo Organizers
Evince Document Viewer
For file management, editing and monitoring you will
see:
PCManFM and Thunar File Managers

Openbox Live CDs: A ComparisonOpenbox Live CDs: A Comparison
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Geany Text Editor
HTop
EeeControl
NetApplet
System Info
Gnome, Root, Sakura, Urxvt and XTerm Terminals
XArchiver
Gnomebaker CD Burning program
There is only one program in the Audio section:
Audacious
The Video section includes two:
Coriander
SMPlayer
You also have extras:
Stellarium
Money Manager Ex
5 or 6 Games
The current full version of Openbox uses tint2 as the
panel. Lxpanel is scheduled to replace tint2 as the
default panel in the forthcoming new version.
You can see here the menu structure and the
choices that the full version of Openbox offers in the
‘More Applications’ section. Notice that it includes
the Printing section which is not in Bonsai.
Stellarium is accessible in the Education as well as
the Sciences section, and that the Finances section
is where you will find Money Manager Ex. Also, the
configuration contains many more programs than
are on the Bonsai iso (top center).

New versions of Openbox and Openbox­Bonsai are
in the works now, and should be released soon. You
know the PCLinuxOS mantra: It’ll be released when
it’s ready.

Openbox Live CDs: A Comparison

International Community
PCLinuxOS Sites

Netherlands

Turkey

Denmark
Czechoslovakia

Italy

Poland

http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
http://www.pclinuxos.com
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Screenshot ShowcaseScreenshot Showcase

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Want To Help?Want To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!
You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.
Join us on our Google Group mailing list.

Posted by mrreality13, August 17, 2011, running LXDE.

mailto:pclinuxos.mag@gmail.com
http://groups.google.com/group/pclinuxos-magazine
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by Darrel Johnston (djohnston)

HTTPS Everywhere

You can install the Firefox add­on by going to their
page linked above. I’ll let the creators describe the
add­on by quoting from their main page.
"HTTPS Everywhere is a Firefox extension produced
as a collaboration between The Tor Project and the
Electronic Frontier Foundation. It encrypts your
communications with a number of major websites.
Many sites on the web offer some limited support for
encryption over HTTPS, but make it difficult to use.
For instance, they may default to unencrypted

HTTP, or fill encrypted pages with links that go back
to the unencrypted site.
The HTTPS Everywhere extension fixes these
problems by rewriting all requests to these sites to
HTTPS."
The nice thing about using it is that there’s no
guesswork involved. If you go to any web page that
supports https protocol, your connection will default
to https. This occurs even if you manually enter the
URL into the address field or if you click on an http
link from another web page. Once the add­on is
installed, there’s not much more to do. The
configuration options are limited, other than writing
custom “rulesets.”

GoogleSharing

Contrary to the name, GoogleSharing ultimately
aims to provide a level of anonymity that will prevent
Google from tracking your searches, movements,
and what websites you visit. You can reach their
main page by clicking the link above. Again, I will let
the authors describe the benefits of using this add­
on by quoting from their main page.
“GoogleSharing is a system that mixes the requests
of many different users together, such that Google is
not capable of telling what is coming from whom.
GoogleSharing aims to do a few very specific things:

• Provide a system that will prevent Google from
collecting information about you from services
which don't require a login.
• Make this system completely transparent to the
user. No special websites, no change to your work
flow.
• Leave your non­Google traffic completely
untouched, unredirected, and unaffected.

The GoogleSharing system consists of a custom
proxy and a Firefox add­on. The proxy works by
generating a pool of GoogleSharing ‘identities’, each
of which contains a cookie issued by Google and an
arbitrary User­Agent for one of several popular
browsers. The Firefox add­on watches for requests
to Google services from your browser, and when
enabled will transparently redirect all of them (except
for things like Gmail) to a GoogleSharing proxy.
There your request is stripped of all identifying
information and replaced with the information from a
GoogleSharing identity.
This ‘GoogleShared’ request is then forwarded on to
Google, and the response is proxied back to you.
Your next request will get a different identity, and the
one you were using before will be assigned to
someone else. By "sharing" these identities, all of
our traffic gets mixed together and is very difficult to
analyze.
The result is that you can transparently use Google
search, images, maps, products, news, etc... without
Google being able to track you by IP address,
Cookie, or any other identifying HTTP headers. And
only your Google traffic is redirected. Everything else
from your browser goes directly to its destination.”

More Firefox Add-onsMore Firefox Add-ons

https://www.eff.org/https-everywhere
http://www.googlesharing.net/
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Download the Firefox add­on here. Once installed,
Google Sharing status will be displayed in Firefox’s
“Add­on Bar” at the bottom of the Firefox browser
window. Clicking the status indicator will toggle it on
and off.

Note that if you use any Google services that require
you to login, the add­on must be disabled or you’ll
be unable to log in. The google.proxysharing.net site
will be enabled by default once the add­on has been
installed. You can find others by viewing the list
here. Configuring the add­on is easy.

You will notice I gave added all that are in the list,
and they are all enabled. If any one of the proxy
share servers times out, the add­on reverts to the
next one in the list.

Scroogle SSL search
I do not have this add­on installed. It simply adds a
search engine to the Firefox list. You can download
the add­on here, or one that displays search results
in English only here.

I do not have this add­on installed because I use
Scroogle’s search page as my home page in every
web browser I use. Although Scroggle’s main page
says that the supported browsers are Firefox,
Microsoft IE7/IE8, Opera and Chrome, I have yet to
find a web browser it does not work with. As long as
the browser supports both HTTPS and SSL, the
search page will work. Scroogle is simply a front end
to Google’s search engine. Note that if you have the
HTTPS Everywhere add­on installed, an attempt to
reach Scroogle’s HTTP main page will automatically
be redirected to Scroogle’s https search page.
The advantage to using Scroogle’s page instead of
Google’s is that your searches are retained by
Scroogle. Google now offers encrypted search, but
they still retain your search queries for advertising
and other purposes. The amount of time Google
retains those queries is still unknown, contrary to
public statements. Scroogle’s access logs are
deleted within 48 hours and are not give to
advertisers.
You can read a short story, Scroogled, written by
Cory Doctorow and published in the October 2007
issue of Radar magazine here.
"We don't know enough about you."

Google CEO Eric Schmidt

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

More Firefox Add­ons

http://pclinuxos.com/?page_id=7
http://www.pclinuxos.com
https://addons.mozilla.org/en-US/firefox/addon/googlesharing/contribute/roadblock/?src=addondetail&version=0.22
https://addons.mozilla.org/en-US/firefox/addon/scroogle-ssl-search/
https://addons.mozilla.org/en-US/firefox/addon/scroogle-ssl-english-search/
https://ssl.scroogle.org/
http://scroogle.org
https://encrypted.google.com/
http://www.scroogle.org/doctorow.html
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by Paul Arnote (parnote)

Since Openbox doesn’t have a panel of its own
(borrowing lxpanel from LXDE or using Tint2
instead), it almost begs for us to use one of the
quick launch bars that are out there. Plus, if you are
using Tint2 as your panel, it does not currently allow
launchers to be used.
Fortunately, there are choices under PCLinuxOS for
a launch bar for your Openbox desktop. All are
relatively lightweight, and give your desktop some
flash and panache. All mimic (to varying degrees)
the Mac OS­X actions of “zooming” when you mouse
over the individual icons.
What are they called? Well, they are adeskbar,
wbar and Cairo­Dock. Of the three, adeskbar is the
lightest weight launch bar, weighing in at only 472
KB, while wbar fills in the middle, weighing in at 842
KB. Cairo­Dock, on the other hand, weighs in at 7.2
MB, with another 8.5 MB for the required plug­ins,
and taking up another 14.1 MB for the optional
themes. As you might imagine, Cairo­Dock offers the
flashiest effects on your desktop. Your choice will be
somewhat dictated by how fancy you want your
launch bar to be, how fast your computer is, how
much RAM you have, and how much hard drive
space you have. Obviously, if neither of those are of
any concern to you, then the choice falls strictly in
the arena of aesthetics and personal preference.

Cairo­Dock
The “flashiest” of the three, by far, is Cairo­Dock.
Just looking at it, you get the impression that there is

more to it. With the default installation of Cairo­Dock
from Synaptic, you get reflections of the icons on the
bar beneath them. When you put it “into motion,” by
moving your mouse over the individual icons, the
icons “zoom,” but can just as easily be made to
rotate and do other “tricks.” Being the largest
download of the three launch bars, Cairo­Dock is
also the most capable.
On my IBM Thinkpad T23 with Openbox installed
(Pentium III, 512 MB RAM, 8 MB video RAM with no
OpenGL capabilities), Cairo­Dock consumes very
few resources, despite being the largest in file size.
Even while activated by moving my mouse over the
launch bar, Cairo­Dock consumed no more than 9%
of the CPU and no more than 8% of my RAM.
Cairo­Dock is divided up into sections. The left­most
section contains your launchers. The middle section
(between the dotted lines) contains the icons of your
minimized applications. The right­most section
contains the icons of your Cairo­Dock plug­ins.
Arranging your icons on Cairo­Dock is as simple as
dragging and dropping the icons to where you want

them, with one caveat: plug­ins cannot co­mingle
with launchers, and launchers cannot co­mingle with
plug­ins.

When I first installed Cairo­Dock from Synaptic, it
contained a host of Gnome­specific applications that
I do not run on Openbox. Fortunately, it’s as easy as
right clicking on the icon you do not want, and
selecting “Remove this launcher” or “Remove this
applet.”

My customized Cairo­Dock without a mouse over.

My customized Cairo­Dock with the mouse hovering over one of the icons.

Openbox: Add A Quick Launch BarOpenbox: Add A Quick Launch Bar
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Similarly, it’s just as easy to add a launcher or
applet. To add a launcher, right click on the left side
of the Cairo­Dock, go to the “Add” menu, then select
“Add a custom launcher” from the menu. A new icon
will be placed in the launcher area.

Right click on the new icon, then “Modify this
launcher.” You will then be able to give the new
launcher a name, specify the command you want to
run, along with the icon you want to use to represent
your new launcher.
When it comes to adding applets to Cairo­Dock, it is
almost as easy. Right click anywhere on your Cairo­
Dock, select the Cairo­Dock menu item, then
“Configure.” You will see the window above. Select
the “Add­ons” tab, and select the applets you want
to display on your Cairo­Dock.

Once you’ve added the applet, you can right click on
it and select “Configure this applet.” When you do,
the window shown two screenshots ago will be
displayed. There, you can set display options for the
selected applet.
As you can see in the previous screen shot, there
are lots of options for Cairo­Dock, divided into four
tabs. Feel free to explore the options. After all, you
can always change them back if you don’t like them.
To make it easier to remember what you changed, it
might be prudent to only change one thing at a time,
just in case you don’t like that particular selection.

wbar
With wbar, you get a Mac OS­X like launch bar that
occupies a minimum of space, while remaining
relatively light on resources and disk space. While
wbar does not have all the options that Cairo­Dock
has, lacking additional plug­in applets that add some
additional functionality, it’s still a quite capable
launch bar. It does one thing, and does it well.
On my Thinkpad T23 running Openbox, wbar
doesn’t even show up in the list of applications when
I run the top command in a terminal window. When I
mouse over wbar, it then shows up in the list of
applications in the top command, consuming
approximately 12% of the CPU and approximately
10% of the available memory, a bit more than Cairo­
Dock, despite its smaller file size.
Like with Cairo­Dock, wbar came set up out of the
box for some Gnome applications that I never use.
Configuring wbar is relatively easy, and it comes
with the configuration tool included on wbar. In fact,
it’s the sixth icon from the right in the screen shot
below.
Clicking on the configuration icon will bring up the
screen shot (next page). Notice the three tabs at the
top of the dialog box.

My customized wbar with the icons zooming from a mouse over.

Openbox: Add A Quick Launch Bar



11

To add a new icon to
your wbar, click on the
“New” button. Provide
a title for your new
launcher, the
command to execute,
and the icon file to use
to represent your new
launcher. If you’re not
sure where icon files
are stored on your
system, they are
typically found in

/usr/share/icons and /usr/share/pixmaps. There are
even some that come with wbar, found in the
/usr/share/pixmaps/wbar directory.
When you select the “Edit” button, the same dialog
box is displayed, with the current information already
filled into the fields. Simply make your changes and
select the “Accept” button. Then, select the “Reload”
button in the configuration dialog box to make your
new (or edited) launcher visible.
You need to be aware, however, of one limitation of
wbar when selecting your icons. Currently, wbar

cannot display *.svg icon files. Rather, it can only
display *.png icon files.
Under the “Preferences” tab, you can set the font
and font size you want wbar to use when it displays
the text of the icon when you mouse over, as well as
the background image you want wbar to use. Among
other things, you can also set wbar’s screen
position.

Under the “Effects” tab, you can set the icon size,
the spacing between the icons, the zoom factor (2.0
is double size), the jump factor (the higher the
number, the more “elevated” the icon is above the

Openbox: Add A Quick Launch Bar
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others when you mouse over the icon), and a
number of other items.
Whenever you make any changes, be sure to hit the
“Reload” button to make your changes take effect in
wbar.

Adeskbar
Adeskbar not only has the smallest file size, but it’s
also the lightest when it comes to using computer
resources. Nothing I did could get adeskbar to show
up in the list of applications when I ran the top
command in a terminal. It didn’t show up when it was
idling, and it did not show up when I moused over
the icons, either.
To be perfectly honest, I originally wasn’t going to
include adeskbar in this article. The first time I
launched it from a terminal session, it was hidden
behind Cairo­Dock, which I had forgotten to stop
before launching adeskbar. So, I had mistakenly
thought that it was not running. Mea culpa. It wasn’t
until I moved my tint2 panel to the top of my screen
and I was running wbar that I decided to give it
another try. Imagine my surprise when adeskbar
appeared!
When you first launch adeskbar, it looks a bit
sparse. Only the menu, audio volume control, clock,
a pair of separators and the session control objects

are present. It is between the separators where you
will want to place your launcher icons.

Configuring adeskbar is quite easy. Simply right click
on the launch bar and select “Preferences.” You will
see the screenshot above.
Under the first tab, “Preferences,” you can set the
size of the launch bar, the “style” used to display
adeskbar, what icon effects you want to use,
whether it’s always visible or if it autohides, and a
few other settings which should be fairly self­
explanatory.

Under the “Position” tab, you can select where on
your screen you want adeskbar to appear.
Under the “Launchers” tab, you can start to fill in the
launchers you want to include on your launch bar.

The easiest way to add applications to your launch
bar to to select them from the “Add from menu”
button. However, due to a problem that adeskbar
has displaying some of the submenu entries on your
system, everything you want to add to your launch
bar may not be available.
In that event, you will need to click on the “Add
custom launcher” button, and fill in the fields in the
dialog box shown on the next page. The
“PCLinuxOS Control Center” entry in the screen shot
was added this way.Adeskbar running at the top of my screen.

Openbox: Add A Quick Launch Bar
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To select the icon you want to display, simply click
on the large button on the left side of the dialog box,
and travel to the location where your icon is stored.
Unlike with wbar though, adeskbar appears to be
perfectly capable of displaying either *.svg or *.png
icon files.
Adding plug ins to adeskbar is even easier. Simply
click on the “Add plug ins” button, and select the
plug in that you want to add. I will caution you,
however, that not all of the plug ins will work. Your
“clue” that the selected plug in will not work will be
that the plug in’s icon will not immediately appear in
the adeskbar launch bar.
Under the “Advanced” tab, you can set some of the
finer aspects of how adeskbar is displayed on your
screen. Feel free to play with the settings (preferably
one at a time) to customize adeskbar on your
computer. One thing I noticed is that you cannot set
the “zoom” level for the icons on your adeskbar to
more than 1.30, or 130%, of the icon’s original size.
Also, you can change the menu icon by double
clicking on the default Gnome “footprint” icon in the
“Launchers” tab, and changing it to something you
might like better in the dialog box that appears.

(Hint: click on the Gnome icon on the large button on
the left and choose your new icon).

Summary
As you can see, there are three excellent choices in
the PCLinuxOS repository for adding a launch bar to
your Openbox installation. In fact, all three of these
can be added to any desktop, regardless if it’s
Gnome, KDE, Xfce, LXDE, or any of the other
graphical desktops.
The adesktop launch bar is the obvious choice if you
are concerned about computer resources and the
amount of disk space consumed – and if you can
tolerate its limitations. The wbar launch bar
represents a good compromise between the low
resource usage of adesktop and the relatively large
hard drive space required by Cairo­Dock. The Cairo­
Dock launch bar represents the pinnacle of “flash”
for your launch bar, if you want the flashiest launch
bar on your desktop.
All three can be set to start up automatically simply
by adding their command to the Openbox
autostart.sh file, as we covered in the July issue of
The PCLinuxOS Magazine.
So what are you waiting for? Adding a launch bar to
your desktop is fun, and it puts your most commonly
used applications only a mouse click away. Plus, it’ll
dazzle your friends when they see it in action.

Visit Us On IRCVisit Us On IRC
• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)

• Go to freenode.net

• Type "/join #pclinuxos­mag"
(without the quotes)

Openbox: Add A Quick Launch Bar

http://www.enkiconsulting.net/
http://pclinuxos.com/?page_id=184
http://www.linpc.us
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Screenshot ShowcaseScreenshot Showcase

Posted by parnote, August 3, 2011, running Openbox.
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Answer on Page 46.

Double Take & Mark's Quick Gimp TipDouble Take & Mark's Quick Gimp Tip

When I'm working on any of my
cartoon features, the process is
pretty much the same. I sketch the toon,
ink, and then scan. Often times, the
scanned image may not align as straight
and square as I need it to be. Rather than
take the original art and reposition ( and
reposition and reposition,etc.) on the
scanner's flatbed, I merely use Gimp's
Rotate function. It's very easy and
straightforward. Just select the rotate tool
from the tool box on the left hand side.

Mark's Quick Gimp Tip
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Click the image and the rotate dialog box
appears. Now, you can either rotate the art
by moving your mouse over and around
the image, or control the rotation in the
dialog box with the slider tool. You can
see from the numerical output how much
rotation is being applied, centering of the
image, etc. Once you have things
aligned, click “Rotate” and you're done!

Find at least seven differences between cartoons.©2
011
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­Mark Szorady is a nationally syndicated cartoonist with georgetoon.com. He blogs at georgetoon.com/blog. Email Mark at georgetoon@gmail.com.

http://www.georgetoon.com
mailto:georgetoon@gmail.com
http://www.gimp.org/
http://www.georgetoon.com/blog
http://www.georgetoon.com/blog
http://www.georgetoon.com/blog/cartoonist-day?comic-book-day/
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OGG MP3

ms_meme's Nook: Bye, Bye Windowsms_meme's Nook: Bye, Bye Windows

Pack up all my cares and woe
Here I go all aglow

Bye Bye Windows
I'm going where that penguin waits

Download all those easy updates

Bye Bye Windows
PCLOS users understand me

I will learn those Man commands they hand me
Boot my 'puter up tonight

I'm going where things work right

Windows Bye Bye

http://www.pclosmag.com/html/Issues/201109/files/byebyewindows.ogg
http://www.pclosmag.com/html/Issues/201109/files/byebyewindows.mp3
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by Archie Arevalo (Archie)

The PCLinuxOS Forum is more than just a place to
get help from your OS issues and problems. It is
also a place to make new friends, and indeed in the
last month I have made two more ­ mmesantos1 and
LKJ. Where did we meet? At the Monthly
Screenshots, of course. I asked them whether they
would be interested in revealing a little bit more
about themselves for the PCLinuxOS Magazine, and
they agreed.

mmesantos1 is Marc Santos and he runs the Linux
Screenshots Forum along with a bunch of people he
says are “a great team”. He is currently employed by

one of the largest printer manufacturers as a tech
support rep for multifunction printers and commercial
high­speed scanners.
Marc is 40 years old, married and has a child. They
live in Virginia Beach, VA.
“I also am an administrator on Ultimate Edition OZ
and help with the look and feel or themeing of the
OZ Unity OS as well as the artwork on the forum. I
also have been helping Mint OS with ISO testing for
some time now.”

LKJ is Louis King Jr., and from Pittsburgh, PA. He
was a professional drummer for over 30 years.
“I have lived with the same woman for over 25 years.
I have a married daughter and a grandson. I've been
using computers for more than 40 years. I am also a

commercial and fine artist. I attended the Art
Institute of Pittsburgh, Pitt and CMU. I worked for
various graphics companies for years. I owned my
own computer graphics company for a time.”
And what got these guys into Linux?
Lou said a good friend who switched from XP and
seemed to be in love with it for awhile but would ask
questions which he couldn't answer without using it.
So he got VirtualBox and installed what his friend
was using and tried to help with his problems. Not
long ago, Lou also found out he could easily
customize the desktop and that became his pastime.
As for Marc, he had a PC with Windows XP that
crashed. He never made backup CDs and he
needed something to run the PC.
“I had heard of Linux but had never installed it. I
figured it was a good time to go ahead and give it
go. After reading up on Linux a bit I thought I had
found a good distro to try so I downloaded the ISO
and burned it to a CD. The distro was Mandriva, the
version I installed the was KDE version. This was
back in 2007. So let’s just say I was hooked from
that point on.”
I hope you've learned to backup your important data,
eh Marc? And how did you guys end up at the
PCLinuxOS Forum?
Lou said PCLinuxOS was one of the many he tried.
“I have played with everything from Arch Linux to
Zenwalk and most things in between. I usually have
at least 30 various Linux flavors installed as guests
at any given time.”

Forum Family & Friends: mmesantos1 & LKJForum Family & Friends: mmesantos1 & LKJ



18

It was pretty much the same with Marc. He even ran
some older versions of PCLinuxOS.
“At that time, I did not know enough to really know
what the best distro would be for me so I had
downloaded and installed many of the Linux OS's to
try and find the one I could use long term. So after
running and tweaking a large amount of the flavors
of Linux, I recently found that PCLinuxOS just
worked for me out of the box. No issues with
hardware or software. I loved that the NVIDIA driver
was installed by default and there was not much that
needed to be done post­install. The OS was very
stable and that was important to me. Also, I have
really enjoyed speaking with members and the team
on PCLinuxOS. All these helped me to finally decide
this was the OS I wanted to have installed on my
PC.”
Marc and Lou are best known for their desktop
screenshots so I asked them about their
preferences.
Lou likes monochromatic themes, whether light or
dark. He finds it rather jarring when someone goes
to the trouble to make their desktop look nice but
has one or more icons sticking out like a sore thumb.
“Appearance is all a matter of taste, of course,” he
said.
Marc likes a minimal look on his desktop.
“By that I do not mean lack of panels or docks but
more of a clean desktop and a wallpaper that looks
good but does not distract me while using my
desktop. I tend to favor a darker look as it is easier
on my eyes but have found some light themes

appealing as well. I guess I prefer a single panel
along with a dock for use as a launcher for my most
used apps. I do not care for icons on my desktop as
it looks messy to me so I tend to avoid the use of
them directly on the desktop and placed them in a
dock. It just gives the whole desktop a neat clean
look that just appeals to me.”
Finally, I asked them about their feelings on
PCLinuxOS.
Marc says, “I feel PCLinuxOS is headed in the right
direction. From what I can see on the development
side, Texstar and the Bacon Brigade are doing a
great job on getting a great looking and working OS.
They do a good job of balancing stable and cutting
edge along with a rolling release model.
“My favorite version of PCLinuxOS would have to be
the KDE Mini, I like the fact that I do not have to go
and uninstall apps that I do not use but instead can
go through and install what I will use, which allows
me to tailor it to my own needs and requirements. As
for the other versions of PCLinuxOS I do like them
but in the end find KDE the most feature complete
for me.”
Lou thinks PCLinuxOS is very stable.
“But I am running everything as virtual machines so I
don't know how realistic my view is.
I have been a Mac user for 25 years. They were the
de facto standard for graphics work. It is also my
personal choice because in all the time I've used it it
has never crashed on me, not once. Plus, there are
applications I needed to use for work.”

Well Lou, I'm pretty sure you're not going to get
scorned in the forum because you are using a Mac.
The PCLinuxOS Forum is, after all, the friendliest
forum in the Linux world.

Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get

Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Forum Family & Friends: mmesantos1 & LKJ

http://www.pclinuxos.com/?page_id=10
http://pclinuxos.com/?page_id=188
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by Charles E. Craig, Jr.
Reprinted with permission
From http://www.renewablepcs.com/

In Linux, there are so many choices, and this
includes the desktop environments and window
managers. Four of the most popular desktop
environments in Linux are GNOME, KDE, Xfce, and
LXDE. All four offer sophisticated point­and­click
graphical user interfaces (GUIs), which are on par
with the desktop environments found in Windows
and Mac OS X.
When you ask different people which of these four is
best, you will likely get many different answers. So
which is the best between GNOME, KDE, Xfce, and
LXDE? Well... it is largely a matter of opinion. Plus,
the capabilities of your computer hardware can also
be important in deciding. For example, users with
older computers will be better served to choose Xfce
or LXDE, while users with newer hardware can get
more desktop effects by choosing GNOME or KDE.
My recommendation would be to try all four of these
desktop environments and decide for yourself which
one works best for you. GNOME, KDE, Xfce, and
LXDE are all excellent, and to varying degrees, each
can be customized in a number of ways.
My personal favorite is GNOME 2.x which is slowly
being replaced by GNOME 3. Although, (very
fortunately), GNOME 2.x is still being kept alive in
Linux Mint, PCLinuxOS Zen­Mini and some other
distros. Of the most recent desktop environments,
my favorite is the newly­released Xfce 4.8.

A Brief Description of GNOME, KDE, Xfce, and
LXDE:
GNOME ­ Currently, GNOME (GNU Network Object
Model Environment) is in the process of transitioning
from version 2.x (which is still used by a large
number of distros that offer GNOME) to version 3,
which was recently released. Beginning with Ubuntu
11.04, there is also the Unity shell that runs on top of
GNOME 2.x. So basically, GNOME at the moment
finds itself in three major manifestations: the old
GNOME 2.x, the new GNOME 3, and Unity. Both
GNOME 3 and Unity (in my opinion) are moves
toward more aesthetically pleasing, yet in some
ways more cumbersome desktops.
While this is my opinion, GNOME 3 and Unity are
nice overall and should appeal to many people. It
should be mentioned that GNOME has a wealth of
applications which are designed for its desktop, but
they can also be used in the other desktop
environments as well; click here to see a list of them.
Linux Mint, Ubuntu, Fedora, and CentOS are major
Linux distros which use GNOME in their main
editions. What follows are descriptions of GNOME
2.x, GNOME 3, and Unity.

GNOME 2.x
Now in the process of becoming the "old school"
GNOME, 2.x has dual taskbars, known as "panels."
One panel is located at the top of the screen in the
form of a menu bar, and an additional panel is found
at the bottom of the screen. Because of this, some
people would say that GNOME 2.x more closely

resembles the Mac OS X operating system in
appearance than it does Microsoft Windows. While
this may be true in its default settings, GNOME 2.x
can be configured to more closely resemble
Windows.
Regarding system resource usage, GNOME 2.x
requires less RAM but more CPU than GNOME 3,
and less RAM and CPU than Unity or KDE but more
than Xfce or LXDE. GNOME 2.x has a menu at the
left of the menu bar (top panel) which is very simple
and easy to use. Unfortunately, this extremely nice
menu does not exist in either GNOME 3 or Unity.
GNOME 2.x is still my favorite desktop and it pains
me to see it potentially fade into the sunset. It is my
personal hope that it will be kept alive and/or forked.
So far, Linux Mint has succeeded in keeping
GNOME 2.x alive.

What Is The Difference Between
GNOME, KDE, Xfce & LXDE?

What Is The Difference Between
GNOME, KDE, Xfce & LXDE?

http://www.renewablepcs.com/
http://en.wikipedia.org/wiki/Desktop_environment
http://en.wikipedia.org/wiki/Window_manager
http://www.gnome.org/
http://www.kde.org/
http://www.xfce.org/
http://lxde.org/
http://en.wikipedia.org/wiki/Graphical_user_interface
http://en.wikipedia.org/wiki/Windows
http://en.wikipedia.org/wiki/Mac_osx
http://www.linuxmint.com/
http://pub.pclos-pl.tk/pclinuxos-ZEN-mini-2011-7.iso
http://www.gnome.org/
http://www.gnu.org/
http://www.ubuntu.com/
http://www.ubuntu.com/
http://en.wikipedia.org/wiki/Unity_%28desktop_environment%29
http://en.wikipedia.org/wiki/List_of_GNOME_applications
http://fedoraproject.org/
http://www.centos.org/
http://en.wikipedia.org/wiki/Taskbar
http://en.wikipedia.org/wiki/Gnome-panel
http://en.wikipedia.org/wiki/Menu_bar
http://en.wikipedia.org/wiki/Menu_%28computing%29
http://en.wikipedia.org/wiki/Fork_%28software_development%29
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Recommended System Requirements for
GNOME 2.x:
Required RAM 384 MB
Required CPU 800 MHz
http://linuxreviews.org/software/desktops/

GNOME 3

The newly released GNOME 3 is a drastic change
from the "classic" GNOME 2.x. While GNOME 3 is
fairly intuitive, for someone who is accustomed to
GNOME 2.x, or any other desktop environment for
that matter, there will still be a considerable amount
of adjustment. In GNOME 3, there is only one panel
located at the top of the desktop, and there is no
longer a traditional menu. To open programs, users
click on "Activities" found on the left side of the
panel, which then gives the options of a program
launcher that appears on the left side of the desktop,
an "Applications" option found on the upper left part

of the desktop (which is the closest thing to a menu),
or they can search for programs using the search
box on the upper right of the desktop. Additionally,
when clicking on "Activities," a desktop switcher
appears on the right side of the desktop.
Another change involves the buttons on the
windows. In GNOME 2.x, and practically every other
desktop environment or window manager, there are
at least three buttons found at the top of each
window: one to exit the window, one to maximize the
window, and one to minimize the window. However,
in GNOME 3, there is only one button which is used
to exit the window, which really takes some getting
used to. Overall though, GNOME 3 is a very simple,
clean, and visually pleasing desktop, but it is also
quite cumbersome.
Recommended System Requirements for
GNOME 3:
Required RAM 768 MB
Required CPU 400 MHz
http://fedoraproject.org/en/get­fedora
Editor’s note: A PCLinuxOS version of GNOME 3.x is
currently being worked on.

Unity
Originally designed by Canonical for use on
netbooks, Unity is now the default desktop in Ubuntu
11.04. There is still the option, however, to run the
"Classic" GNOME 2.x desktop environment, which

requires less system resources and has more
flexibility than Unity. Also, Unity requires more
system resources than GNOME 3 or KDE, not to
mention all of the other popular Linux desktop
environments. In Unity, there is one panel and it is
always at the top of the desktop. Additionally, there
is a dock­like program launcher which is always on
the left side of the desktop. In appearance, Unity
very much resembles a Mac OS X desktop where
the dock has been positioned on the left side.
One issue I personally have with Unity is that it does
not have a "traditional" menu like GNOME 2.x,
although users can right­click on the "Applications"
icon found on the program launcher to find
something that resembles a menu. Another way to
access programs in Unity is by clicking on the
Ubuntu symbol found on the left side of the panel.
This opens up a box where users can type in the
name of desired programs to open them. Unity, in
my opinion, seems less cumbersome than GNOME
3 in some respects, but it still feels awkward at
times. Despite this, Unity, like GNOME 3, is very
simple, clean, and visually pleasing.

What Is The Difference Between GNOME, KDE, Xfce & LXDE?

http://linuxreviews.org/software/desktops/
http://fedoraproject.org/en/get-fedora
http://www.canonical.com/
http://en.wikipedia.org/wiki/Netbook
http://en.wikipedia.org/wiki/Dock_%28computing%29
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Recommended System Requirements for Unity:
Required RAM 1 GB
Required CPU 1 GHz
http://askubuntu.com/questions/22402/will­ubuntu­
11­04­work­on­my­old­pc

KDE

KDE ­ In many ways, KDE (K Desktop Environment)
is very similar in appearance to Microsoft Windows,
and Windows users will likely feel very much at
home when using KDE. Just like in Windows, users
access the KDE menu by clicking on the the left side
of the panel. By default, KDE has a single menu bar
at the bottom of the screen. However, this may be
changed by the user. With its Plasma Workspaces,
KDE is arguably the most visually pleasing of all the

Linux desktops. While KDE is more polished in
appearance and has more point­and­click options
and "eye candy" than GNOME 2.x, Xfce, or LXDE, it
is also more resource hungry. On the other hand,
KDE requires less system resources than Ubuntu's
Unity, and less RAM than GNOME 3.
Like GNOME, KDE includes a large number of
applications which are designed to be used in its
desktop, many of which have a name that begins
with the letter "K." For example, Konqueror is the
default web browser, Dolphin is the default file
manager, and KStars is a desktop planetarium. Also,
like the GNOME applications, the KDE applications
can be used in other desktop environments. You can
click here to see a list of KDE applications.
OpenSUSE, PCLinuxOS, and Mandriva are some
major Linux distros running KDE in their main
editions. Kubuntu is the KDE version of Ubuntu.
With all of this being said, KDE is an excellent
desktop environment that is definitely worth
consideration.
Recommended System Requirements for KDE:
Required RAM 615 MB
Required CPU 1 GHz
http://itmanagement.earthweb.com/osrc/article.php/3
930006/GNOME­vs­KDE­The­Latest­Round.htm

Xfce
Xfce ­ Less resource­hungry than GNOME or KDE,
Xfce is a great choice for older computers, and it is

still a full­fledged desktop environment that offers a
great deal to the user. In my opinion, Xfce provides
a nice balance between functionality and
conservation of system resources, while still having
a beautiful desktop. In its default appearance, the
newly­released Xfce 4.8 very much resembles Mac
OS X with its dock­like panel found at the bottom of
the desktop. Users can drag their favorite
applications from the menu (found on the left side of
the upper panel) and place them on the bottom
dock/panel in a similar manner as can be done in
Mac OS X. Editor’s note: Xfce 4.8.1 does not exhibit this
behavior under the default installation of PCLinuxOS.
Rather, the panels of Phoenix (the Xfce version of
PCLinuxOS), behave much as they did under Xfce 4.6.2.
Just like GNOME 2.x and KDE, Xfce may easily be
customized to more closely resemble Windows, or to
be configured any way as desired. Xubuntu is the
Xfce version of Ubuntu, Phoenix is the Xfce version
of PCLinuxOS, and Linux Mint offers an excellent

What Is The Difference Between GNOME, KDE, Xfce & LXDE?

http://askubuntu.com/questions/22402/will-ubuntu-11-04-work-on-my-old-pc
http://www.kde.org/
http://www.konqueror.org/
http://edu.kde.org/kstars/
http://en.wikipedia.org/wiki/List_of_KDE_applications
http://www.opensuse.org/en/
http://pclinuxos.com/
http://www2.mandriva.com/
http://www.kubuntu.org/
http://itmanagement.earthweb.com/osrc/article.php/3930006/GNOME-vs-KDE-The-Latest-Round.htm
http://www.xfce.org/
http://www.xubuntu.org/
http://cozmodesigns.co.uk/phoenix/
http://en.wikipedia.org/wiki/KDE_Plasma_Workspaces


22

community edition with Xfce. Many other Linux
distros offer Xfce versions as well. For those, such
as myself, who like the GNOME 2.x desktop and are
not completely satisfied with the changes in GNOME
3 or Unity, Xfce 4.8 could be a great fit.
Recommended System Requirements for Xfce:
Required RAM 192 MB
Required CPU 300 MHz
http://wiki.xfce.org/minimum_requirements

LXDE

LXDE ­ Of the four major Linux desktop
environments, LXDE (Lightweight X11 Desktop
Environment) is the least resource­hungry, which
makes it an outstanding choice for older computers.
It will also run extremely fast on newer computers.
Even with its super­efficiency, LXDE is still a nice
and feature­rich desktop environment that has

menus which are simple and straightforward and
very easy to navigate.
In its default appearance, LXDE resembles older
versions of Windows (such as Windows 98 or 2000),
with a single panel at the bottom of the desktop and
a menu found on the left side of that panel. But like
GNOME 2.x, KDE, and XFCE, it can be customized
in a variety of ways. Lubuntu (the LXDE version of
Ubuntu), Peppermint OS, and Knoppix are popular
distros which have LXDE as their default desktop
environment. Many other Linux distros, such as
PCLinuxOS, offer LXDE versions as well.
Recommended System Requirements for LXDE:
Required RAM 128 MB
Required CPU 266 MHz
http://lxde.sourceforge.net/about.html

Popular Window Managers in Linux:
GNOME, KDE, Xfce, and LXDE are complete
desktop environments, each of which come with
their own programs and applications, menus, icons,
a file manager, and a window manager. Window
managers are, as the term suggests, simply used to
manage the opening and closing of programs in a
graphical, point­and­click windowed desktop.
Window managers can be used as a component of a
desktop environment, or they can run on their own.
GNOME 2.x uses Metacity as its default window
manager, GNOME 3 uses Mutter, KDE uses KWin,
Xfce uses Xfwm, and LXDE uses OpenBox. Some

other examples of popular X11 window managers
are Fluxbox, IceWM, JWM, and Enlightenment. To
varying degrees all of these window managers are
less resource­hungry than GNOME, KDE, Xfce, and
even LXDE, and are great for extremely old
computers. Editor’s note: PCLinuxOS offers standalone
versions running Fluxbox, IceWM, Enlightenment and
Openbox.

Enlightenment ­ Though Enlightenment (E17) is a
window manager, it can also be considered a
"desktop shell," and the project has grown to
encompass a number of applications and libraries
which are together known as EFL. Because of its
many features, many people even consider
Enlightenment (a.k.a. "E") to be a full­fledged
desktop environment. One very nice feature of
Enlightenment is its flexibility, which among other
things, allows it to run on a wide variety of devices

What Is The Difference Between GNOME, KDE, Xfce & LXDE?
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that includes mobile phones, game systems,
laptops, and powerful desktop computers.
Enlightenment requires less system resources than
the GNOME, KDE, Xfce, or even LXDE, yet it also is
quite visually appealing. It also offers a lot of "eye
candy," which is amazing, given its very small
footprint. The Enlightenment desktop is somewhat
unique in its appearance, and users can simply click
anywhere on it to access the menu. Bodhi Linux is a
popular distro that uses Enlightenment as its default
desktop.
Recommended System Requirements for
Enlightenment (E17) to be fully functional on a
netbook, laptop, or desktop:
Required RAM 64 MB
Required CPU 200 MHz
http://www.enlightenment.org/p.php?p=about&l=en

A Comparison Desktop Environment / Window
Manager RAM and CPU Usage:
Below are the results of an "unscientific" test I
conducted with various desktop environments and
window managers. In this test, I ran Unity in Ubuntu
11.04, and GNOME 3 in Fedora 15, both from live
CDs. Then I used the GNOME system monitor in
Unity and GNOME 3 to record the lowest RAM and
CPU usage numbers, while each system was at idle
after a fresh boot with no other open applications.

I installed and ran the other nine desktop
environments/window managers in Lubuntu 11.04
and Xubuntu 11.04 through VirtualBox and opened
the LX Task Manager (lxtask) to record the lowest
RAM and CPU usage numbers, while each system
was at idle after a fresh boot with no other open
applications. As a side note, I opened Windows 7 on
a newer HP laptop and recorded the system usage
numbers. While Windows 7 used 0% of the CPU at
idle from a fresh boot which was better than any of
the Linux desktop environments or window
managers, it used significantly more RAM at 1.13
GB, which is three times more than KDE 4.6. Below
are my results for the Linux desktop environments
(DE) and window managers (WM):
DE/WM RAM used % CPU used Type
KDE 4.6 363 MB 4 % DE
Unity 271 MB 14% DE (shell)
GNOME 3 193 MB 10% DE
GNOME 2 191 MB 1 % DE
XFCE 4.8 144 MB 10 % DE
LXDE 85 MB 10 % DE
IceWM 85 MB 2 % WM
Enlightenment (E17 Standard)

72 MB 1 % WM

Fluxbox 69 MB 1 % WM
OpenBox 60 MB 1 % WM
JWM 58 MB 1 % WM
Regarding the desktop environments, I was
surprised that the "lighter­weight" XFCE and LXDE
consumed more of the CPU while at idle than KDE
or GNOME 2.x. As far as the window managers, it
was interesting that their performances were very
close to each other, with IceWM consuming the most
RAM and CPU, and JWM consuming the least RAM
and CPU. It was no surprise to me that all of the
window managers used less RAM and CPU than
any of the desktop environments, with the exception
of IceWM which used slightly more CPU than
GNOME 2.x. Finally, it should be mentioned that this
was simply a test I completed out of simple curiosity,
and while the results are interesting, it is probably
best for you to use the recommended system
requirements for each desktop environment as a
guide when deciding which one is best for your
computer.
*** So far, I have not been able to run GNOME 3 or
Unity in VirtualBox on my system, even when I
increased the allocated amounts of RAM and video
memory to their maximums. So instead, I used live
CDs to run Unity in Ubuntu 11.04, and GNOME 3 in
Fedora 15.

Advertisement
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Interchangeability / Flexibility of Linux Desktop
Environments:

One great feature of Linux is that programs/
applications that are made to run in any one of these
desktop environments will normally work in the
others. For example, GNOME Games can also run
in KDE, Xfce, or LXDE, while KDE Games can
likewise run in GNOME, Xfce, and LXDE. It should
also be mentioned that many major Linux distros
offer versions in multiple desktop environments,
which includes all four of the desktop environments
described above. It is even possible to have any
combination of GNOME, KDE, Xfce, and LXDE
installed simultaneously on your Linux system.
However, when installing multiple Linux desktop
environments on the same computer, it is important
to know that there will be many redundancies
between similar applications (system tools, games,
etc.) found within each desktop environment.
Another outstanding feature of Linux desktop
environments is their flexibility, which gives users the
ability to customize a desktop environment to make

it look quite unique, or to imitate the look of other
operating systems such as Windows and Mac OS X.
Click here to see a larger screenshot of the GNOME
2.x desktop in Linux Mint 9, which has been
customized to resemble Mac OS X, using Docky.
Like other software in Linux Mint, Docky can be
downloaded and installed from the Software
Manager.
The default desktop in Dreamlinux looks much like
Mac OS X, and Zorin OS has a nice feature called
"Look Changer" which allows users to choose the
normal GNOME desktop, or from desktops very
similar to either Windows 7 or XP. Click here to see
a larger screenshot of Zorin OS in the Windows XP
mode, but without the legion of viruses. Click here to
see more examples of customized Linux desktops.
Below are links to websites which offer a wide
variety of eye candy for the GNOME, KDE, and
XFCE desktops:

http://GNOME­Look.org/
http://KDE­Look.org/
http://Xfce­Look.org/
Click here to learn more about the differences
between the various Linux desktop environments in
an article by linuxreviews.org. Wikipedia also
provides an excellent comparison of the various
desktop environments in an article entitled
"Comparison of X Window System Desktop
Environments". Another great resource is the
Windows Managers for X website.
If you would like to read the original blog entry,
please visit http://www.renewablepcs.com/about­
linux/kde­gnome­or­xfce.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

What Is The Difference Between GNOME, KDE, Xfce & LXDE?
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http://www.renewablepcs.com/about-linux/kde-gnome-or-xfce/mac-os-x-lookalike
http://www.go-docky.com/
http://www.dreamlinux.net/
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http://www.renewablepcs.com/about-linux/kde-gnome-or-xfce/zorin-os-screenshot
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http://gnome-look.org/
http://kde-look.org/
http://xfce-look.org/
http://linuxreviews.org/software/desktops/
http://linuxreviews.org/
http://www.wikipedia.org/
http://en.wikipedia.org/wiki/Comparison_of_X_Window_System_desktop_environments
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by Paul Arnote (parnote)

One nice thing about many of the Linux desktop
environments and window managers is the ability to
customize the appearance of your desktop. This
doesn’t mean only wallpaper. This also includes
window appearance. Openbox is no different in this
aspect. Additionally, the information in this article
applies equally to LXDE, since it uses Openbox as
its window manager.
While it’s possible to create your own Openbox
theme from scratch by hand (obviously, since
someone had to have created the first Openbox
theme), you will find it easier to find a theme that you
like and modify it to suit your individual tastes. The
latter is the path we’ll take with this article. Typically,
you install and change your Openbox themes
through the OBConf utility. However, you can also
manually install them, provided you place them in
the proper location. You can find many ready­to­go
Openbox themes from other Openbox users.
If you choose to modify one of your favorite themes,
I strongly urge you to make a copy of the theme and
make your modifications to the copy. This way, if you
royally screw up the modification, the original
remains unaltered and intact.
To get started, it’s important to know where
Openbox themes are stored. Your themes can by
“system­wide” themes (accessible to all users on a
computer) or user­specific themes (accessible to
only that particular user). System­wide themes are
stored in /usr/share/themes, and you will need

root access to make modifications. User­specific
themes are stored in either ~/.local/themes or
~/.themes. The advantage to these themes is that
you can modify them without having root access.
The disadvantage is that they are available only to
one particular user, unless you copy the theme to
/usr/share/themes for all users to access. To do
the latter, you will need root access. I tend to use the
user­specific location, and if I come up with
something that I like, I can then move them to the
folder for system­wide themes, sharing my new
theme with all the users on my computer.
Much of what controls the appearance of a theme in
Openbox is stored in an X resource database file,
called themerc. It’s no more than a specially
formatted text file. Typically, this file is stored in the
themes folder, which takes on the form of another
folder with the name of the theme, containing
another folder named openbox­3. So, the “Appleish”
themerc file, the theme upon which I based my
modifications off of, is stored in
/usr/share/themes/Appleish/openbox­3. The
other files in the folder are the graphics files that
form the window decorations.
Most likely a byproduct of its light weight, the choice
of graphics format used to create the window
decorations in Openbox imposes some inherent
limitations. The graphics have to be in the *.xbm
format, which is a binary color format. In case that’s
not striking you just right, let me put it this way: you
can use any colors you want, so long as they are
black or white. Essentially, the *.xbm file acts like a
mask on the window title bar, and the instructions in
the themerc file tell Openbox how to paint that mask
and with what color. Face it: there aren’t a lot of

things you can do with a binary color graphic file
format.
Below is a collection of all the graphic files in the
Appleish theme, with labels:

Pretty plain, huh? As you might already be able to
tell, there aren’t a lot of options, and this somewhat
restricts what you can do in an Openbox theme.
Conversely, xfwm (the window manager for Xfce)
allows the use of *.xpm files. Xpm files allow the use
of color, giving you many, many more options in the
appearance of your window decorations.
Below is the unaltered Appleish Openbox theme,
showing an active and inactive window:

In the above image, I held the cursor over the exit
button on the window title bar (putting the window
decoration into the “hover” state), so you can see
how the image is painted by the themerc file.

Openbox: Customize Your Window ThemesOpenbox: Customize Your Window Themes
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Below is my altered version of Appleish:

Again, I held the cursor over the close button of the
active window (“hovered”) so you can see how the
themerc file has been altered to paint the window
decorations in the customized version. Notice how
the close button is now painted yellow (I can’t help
myself, since yellow has always been my favorite
color), instead of dark gray.
Other differences you might notice include a
darkening of the window titlebar, a change of the
active titlebar font color to white, and the inclusion of
the “raised” drawing flag for the window titlebar. In
the altered Appleish theme, I left the inactive window
settings unchanged from the original.
Remember that all of the painting of the window
titlebars, the titlebar fonts, and the colors to use for
many other settings, are under the control of the
themerc file for the particular theme you are using.
Although colors can be expressed as names of
colors (as recognized by Xorg) and RGB:xx:xx:xx
format, the most common format for specifying
colors is the six digit hexidecimal color notation that
most associate with how you express colors in an
HTML file. Black becomes #000000, bright red is
#ff0000, bright green is #00ff00, bright blue is
#0000ff, and white is #ffffff. Other colors can be
created by creating combinations of the three color
intensities. Just be sure to keep each digit in the
range of 0 to F.

Fortunately, all of the available options for the the
themerc file are documented fully and extremely well
in the Openbox Wiki. Instead of trying to cover them
here, I’m going to refer you to this excellent resource
instead. They have already done an outstanding job
of explaining all the relevant information there.

Summary
A quick, cursory look at a themerc file may be
enough to scare some users away from customizing

their Openbox themes. But given the fact that the
themerc file is little more than a specially formatted
text file, and the additional fact that the themerc file
options are so well documented, you owe it to
yourself to at least give it a try.
Granted, while my first attempts at modifying my
Appleish theme were quite horrendous in
appearance, I quickly got a handle on what I needed
to do and ended up making a theme modification
that is uniquely mine, and one that suits me even
more than the original Appleish theme.

Screenshot ShowcaseScreenshot Showcase

Posted by siouxfox, August 9, 2011, running KDE4.

Openbox: Customize Your Window Themes
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by Meemaw & Paul Arnote (parnote)

We have gotten our newsletter created, converted to
a PDF and published (or mailed.) However, here are
a few last little things that will make the next
newsletter, brochure or magazine a little easier to
create.

Linking the Table of Contents to the Article
If you have a large newsletter or magazine, you can
link each article listed in the table of contents (of the
PDF) directly to the page where that article starts.
Just like doing a web link, use the link tool (the pair
of shoes) and draw a frame around your article
name in the table of contents. Double­clicking the
frame gives you the link window. Rather than
choosing ‘Exterior web link’, you will choose ‘Link’.
When you do that, you will see the first entry says
‘Page’. If you have all your pages in order the way
you want them, put the page number of the article
into that box and click OK.
Be sure to change
the last number in
the page positioning
from 612 points to 0
points. Otherwise,
the link will point to
the bottom of the
page, instead of the
top of the page.

Spacing for Text and Images
When you place an image, and choose the text to
wrap around the image, you will notice that the text
is usually ‘crammed’ right up against the edge of the
image. We will need to space that out a bit so your
article reads better, and it helps give your document
a more polished appearance. There are a few ways
to do this, depending on where the space between
the image and text is located.
For the first method, note the size of the image, and
place a polygon or text frame in the image layer,
with text flow around it. Then, change the size so
that it's three (3) points wider or longer on the side
you need it to space against the text. You may have
to slightly alter the position of that item to
accommodate the spacing, if it's on the left side of
an image, by reducing the X­Pos setting by an equal
three (3) points.
For the second method, if you need the extra
spacing along just one side of an image, because
the text is butting right up against one edge of an

image, the easiest way is to
duplicate the picture, change it to a
polygon (or text frame), then
increase the height or width of the
image by three (3) points. I
increased it by much more for the
purposes of this article (top right).
Finally, another way to do it is to
place a very thin invisible polygon
along the edge of the image where
the spacing is needed. You guessed
it: the height or width of the invisible

polygon (made by setting the border and fill color to
“none”) is three (3) points.
Of course, you can always increase the size of the
“border space” if you want. Just be sure to be
consistent throughout your document, so you
preserve that polished appearance and so that your
document doesn’t appear amateurish.
Remember, everything is done in the image layer.

Dropcaps and Alignment Issues
Dropcaps are occasionally used in documents. They
are done exactly like placing a small picture at the
beginning of an article, except that it's text; typically
a different font, but a much larger size and color.
Just as with pics, you can set the alignment to the

Using Scribus, Part 9: Tips & TricksUsing Scribus, Part 9: Tips & Tricks
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baseline or the top of the character you use as a
drop cap.
In the example, I just changed the first letter in the
top box to a different font
and size. If you do it that
way, it will automatically
align everything with the
bottom of the text. On the
second example, I placed
a separate text box with
the first letter in it. (You an
see the boundaries of the
text frames.) I also defined
the text flow in the ‘Shape’
section of the ‘Properties’
window. You have to work
a little bit to line up things
as they need to be. While
it does offer a different
appearance for the
beginning of a paragraph
you probably should only
use dropcaps sparingly.

Groups: What’s the Best Way?
Grouping items is really the best way to make sure
something looks the same every time you use it. The
header for my newsletter is several items all grouped
together. We see the screenshot showcase in this
magazine every month, and it is also many items
grouped together. If you design something with
many parts and want to make sure they all stay
together when moved, you should group them. If you
are going to want to reuse something multiple times,
the best way to keep it is to group it first, then add it

to your scrapbook. When you reuse it and need text
flow, there are some options on how to do that.
The Scribus developers are working on fixing the
option to apply text flow around a grouped object,
but it is not “scheduled” to be “fixed” until Scribus
1.5.x (it was working up through Scribus 1.3.4, but
then stopped working in subsequent releases,
including the current one, 1.3.9). Despite the Scribus
developers being rather unresponsive to requests to
fix this problem and dragging their feet on providing
a solution (What? Another 12 versions of Scribus
before we can finally have this once­working feature
fixed?), there are workarounds.
First, you can use the options listed above to provide
that extra space around an image.
Second, you can ungroup it, and make the
background of the grouped object only have textflow
around it.

Boxes!
Everything doesn’t always have to be square! Some
of the boxes in my newsletter have rounded corners.
I think it softens the look of the document. For that
reason, you want to use them sparingly, or only on
documents that aren’t required to be very sharp and
precise. (I usually have only one on each page).
Insert the polygon where you want it to be, then click
on ‘Shape’. Towards the top, you will see a box titled
‘Rounded Corners’. You can use the up arrow to
designate the amount of rounding you want, and you
can keep clicking the up arrow until you have a
circle!

You can see the corners changing as you click on
the up arrow, so you can stop when it is the way you
want it. After you get used to the setting, you will
probably know what number you want in that box.
Notice that you can do this with shapes AND text
frames. I generally use a polygon if I want a rounded
border, and put the text frame over it. That way, my
left­aligned text is straight at the left edge. If you
round off a text frame, your text will follow the
rounding at the corners. You may want to use this
for a different look in your document. After you
experiment a little, I’m sure you will find something
that looks the way you want it to look. If you round
off the box, you can round off your text flow as well
by clicking ‘Use Frame Shape’ (but you’ll have to
experiment with the flow to make sure it looks right,
too).

Using Scribus, Part 9: Tips & Tricks
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Layers, Layers, Layers … and more Layers
When I started using Scribus, it seemed like one
layer was good enough. However, as I have
continued to use it, I use more layers than ever.
Sometimes it seems like it’s more work to use more
layers, but that isn’t the case.
One of the major reasons to use more layers is that
each feature of your document (text, images, links)
are contained in one spot. This means you can’t
click and drag an image out of place if you are
adding links, and you cant move a link if you are
adding another image.
As I said in an earlier article, the company I work for
has a brochure they print in English and Spanish.
Each language is on its own layer, and the images
are on another layer. They can work on them both at
the same time and make visible whichever language
layer they need to convert to PDF.
Say they want to update the brochure with edited
text and new images. They can delete the image
layer and start again, or just replace the images in
the document with new ones. They can even have
different images in their Spanish version than they
have in their English version. That would required
another graphics layer, with the Spanish layers
visible in one PDF and the English layers visible in
the other.
We can’t emphasize this one enough! The more
layers, the better. As you can see from the example
above, it adds a lot of flexibility to your document.
Plus, in the end, it makes laying out your document
much easier and adds a lot of organization to the
process.

Workspace Arrangement
Generally, the arrangement of your workspace
depends on your screen size, but on all the
computers I use, Scribus seems to be the most
usable to me when the main document window is at
the left of the screen and the Properties and Layers
windows are at the right side of the screen. They are
the two windows you will use the most besides the
document window. All the other windows you will
use are available in the ‘Windows’ menu.

Our Chief Editor uses a slightly different
arrangement, where he has his Properties window at
the left side of the screen, the Layers window at the
right edge of the screen, with the Scrapbook window
then positioned just to the left of the Layers window.
He leaves both of the windows on the right shaded
up until they are needed. Often times, he also leaves

his Properties window shaded up until he needs to
access the data displayed there, so he can see the
entire screen when he’s laying out the magazine’s
articles every month.

The point here is to take the time to arrange your
workspace in a manner that fits best with your
workflow habits in Scribus. If you are a new user,
you might not have yet discovered your workflow
habits. There is no one “right” way to arrange your
workspace, so don’t be afraid to experiment until you
find an arrangement that best suits you.

Choices of Graphics File Formats
Some graphics formats look better than others (have
a higher image quality), and take up more space.
Others save space, and sacrifice image quality. The
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preferred graphics format is to use PNG graphics,
due to their lossless compression. In fact, the
Scribus developers recommend using the PNG
graphic file format whenever possible. Yet, due to
their lossless compression, PNG files tend to be a bit
larger than equivalent JPG files – which use a lossy
compression algorithm. The JPG lossy compression
algorithm causes small details to be dropped out of
the final image each time it is saved. The result is
that the PNG file has much better quality, but JPG
files have much smaller files sizes.
For The PCLinuxOS Magazine, we use a mixture of
PNG and JPG files. Where quality matters most (and
that is for the graphics that accompany most of the
articles you see in the magazine), we use PNG files.
However, to save space (and to help reduce the file
size of the PDF file you have to download), all of the
Screenshot Showcase files are changed to 600 pixel
wide JPG files.
While we’re talking about graphic file formats,
Scribus can import SVG vector graphic files.
However, use caution when using SVG files. Pure
SVG files can be quite small in relation to the image
information they contain. Plus, they are scalable
without a loss of image quality. However, their file
sizes can be quite large, especially if a number of
PNG files were used to help make the background
of the SVG file. Because the entire SVG file is
imported, part and parcel, into the Scribus
document, the size of your Scribus document grows
by the exact same amount. Even when you
compress the PDF output from Scribus, you’ll end up
with an enormous file size for your PDF.
A better option is to export your SVG file from
Inkscape (or other vector graphics application) to a

PNG file that is closer to the image size you need in
Scribus. Then, use that PNG file in place of
importing the actual SVG file.

Scribus Resources
Certainly, there is far more information available
about Scribus than we’ve covered here, in our
Scribus series. If you want to learn more about using
Scribus, here is a short list of additional resources
that you might find helpful:
Getting Started With Scribus:
http://wiki.scribus.net/canvas/Get_Started_with_Scri
bus
Scribus How­To:
http://wiki.scribus.net/canvas/Category:HOWTO
Scribus Links:
http://wiki.scribus.net/canvas/Scribus_Links
ScribusStuff.org:
http://scribusstuff.org/index.php?xsortmode=alpha&l
ogpage=0&xcontentmode=642&page=1 Contains all
sorts of predefined templates for Scribus, including
those for CD case inserts, newsletters, magazines,
flyers, brochures, and all sorts of other cool things.
Scribus User’s Manual: http://docs.scribus.net/
LinuxJournal.com: Go to
http://www.linuxjournal.com, and enter “scribus”
(without the quotes) into the search box. There, you
will find all sorts of articles on Scribus, written at all
different user skill levels.

Summary
As you can see, Scribus is a very capable desktop
publishing application. It’s open source and free,
which is hard to beat. Unfortunately, most desktop
publishing applications, such as Microsoft Publisher
and Adobe PageMaker, use closed, proprietary file
formats that are not well documented. As a result,
it’s virtually impossible to open the file from one
desktop publishing application on a different desktop
publishing application. This is one area in the
software arena where standards have not been
established.
We hope that all your questions have been
answered throughout this series, and that it has
spawned several other questions of your own.
Scribus is not a difficult application to use. Rather, it
requires a lot of planning and forethought.
So, unleash your inner publisher and creativity, and
enjoy using Scribus!
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by Meemaw

We have come to the last four viewers in this series.
These are the four that do the most in terms of
viewing, editing and manipulation.

Gwenview
Since Gwenview is part of the KDE graphics
package, it closely resembles Konqueror (at least it
does to me). It also requires many KDE files when
you install it.

When you open Gwenview, you will see a window
similar to the one above. As you view pictures,
Gwenview will add icons for those folders on the left
side of the window. When you want to view images
in one of the folders, simply double­click the folder.

You will see the images as thumbnails. You can
configure Gwenview to view only the thumbnails or
can view a sidebar with tabs for Folders, Meta
Information, and Operations. Image Operations
include crop, rotate, and resize and File Operations
include rename, trash, delete, copy and move, and
the ‘Open with...’ command.

The plugins menu contains loads of image
manipulation items. Under Plugins > Images you
will have the same Flip and Rotate functions along
with Convert to black & white, Print Images and
Email Images. In Plugins > Tools, you see
Advanced Slideshow, Create Calendar, Blend
bracketed images, OpenGL Image Viewer and Raw
Image Converter. Plugins > Import will let you
import from several Internet sites, as well as your
scanner and a remote computer. Plugins > Export
allow you to export your photos to even more
Internet sites, and to a remote computer. The last

section, Plugins > Batch Processing, gives you
many processing operations you can perform on a
group of images if you wish. I generally only batch
rename or batch convert, but there are more here.

Photo Viewers Galore, Part 5Photo Viewers Galore, Part 5
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DigiKam
DigiKam is a full­featured program, allowing you to
transfer photos from your digital camera to you
computer, then organize and edit them as well. Like
Gwenview, it’s a KDE graphics viewer and editor,
and it also has a lot of KDE library dependencies.
When you open digiKam for the first time, you will be
asked a series of questions regarding setup and
how you want newly imported images handled by
the program. Then you will get the following window,
plus a Tip of the Day.

digiKam has many image manipulation tools. You
can create a calendar or edit your photos (including
red­eye removal.) You can also search, print and
email your photos (center top).

As you can see, the Image menu has even more
tools (rotate, flip, convert to black & white, print,
email, rename and even move to trash).

I was curious about the entry in the Image menu ­
‘Place onto Light Table’, which I had never seen

before. You can choose one or more pictures and
place them on the light table. From there you can
manipulate them further.

Unchecking ‘Synchronize’ in the tool bar, you can
zoom in on an aspect of your picture. Going to File >
Edit gives you yet another window where all the
editing tools are located. I put a frame around this
image.

Photo Viewers Galore, Part 5
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Picasa
Picasa is Linux, Mac & Win compatible, with lots of
editing and viewing options. When you first open it,
Picasa will, by default, scan your entire computer or
some selected folders to build a database of photos.
If you add a new folder to your /home, you can add
that folder to Picasa to include those photos in your
database. You will have a sidebar that will include all
your scanned directories.

If you choose a photo to edit, it will show in a
window with a tabbed section on the left. The three
tabs are in the illustration which follows (center top):

As you can see, there are many ways you can edit
your photos. You can also export, print or email
them, and also post them to websites and make a
collage with them.

Picasa is a very complete program. It is designed to
keep your photos scanned and organized, not only
by folder, but by date. If you wish, you can disable
the setting where it opens and immediately scans for
new photos by clicking Tools > Folder Manager.
From there, you can choose Scan once, Scan
always, or Remove from Picasa for each folder. My
personal preference is to choose for myself when I
want my folders scanned, so many of mine say
Remove from Picasa.

XnView
The first thing I discovered about XnView is that
there are two versions in the repo. You will find
XnView (v. 1.70) and XnViewMP (v. 0.35beta). Even

though it is labeled as unstable, the beta version
looks much better to me. It seems to be more
complete, and better arranged.

The main browser has a folder list (top left of
window) along with a section showing the
thumbnails in whatever folder you have highlighted
(top right). When you choose a photo, you will see a
larger version of it (lower right of window), along with
all sorts of information to the left of the photo
(above).

If you don’t like the way the windows are arranged,
go to View > Layout and choose one you like better.
Notice in the layout on the next page, the Info tab is
with the Preview tab at the right edge of the window.
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The menu bar and toolbar are under the area for
tabs across the top. The tools are Fullscreen, View
As.... (Thumbnails only or thumbnails with labels or
icons, etc), Sort By (Name Date, Size...., Thumbnail
size (You can choose different sizes to view) ,
Ratings and Colors (to rate or color­code your pics),
Category (can sort people from flowers, for
example), Show files in subfolder, Capture, Export,
Batch Convert, Back, Forward, Up (to a higher
directory), Rotate Counterclockwise, Rotate
Clockwise, Layout save, Settings and About.

Also notice that there is a separate toolbar above
your icon group on the left. You have Back, Forward,
New Folder, Edit, Delete Sort By, Filter, and View As
(thumbnails, icons, etc.) along with a slider which
makes those thumbnails larger if you wish.

If you want to edit photos, simply double­click on
that photo and it will open in a new tab (the tabs are
at the top of the main window). Then you can switch
back & forth between your open photos.

The menu is different now and also includes all the
tools for editing your photo.
Going back to the browser tab and
clicking Tools > Capture or clicking the

camera icon on the
toolbar, you are able
to take a screenshot
of whatever you
want.... except for an
XnView window!

When you configure your capture
parameters and click OK, the whole
XnView window disappears until the
screenshot is finished and then it
reappears with your screenshot (right).

In this five­part series, I have covered twenty­four
photo viewers, from some that are simple viewers up
to those that import and export your photos from
different sources, edit and catalog your photos and
make posters, calendars, collages and albums. I
hope you have found one or two photo viewers that
fit your needs. From all those covered, I’m sure the
choice wasn’t easy, as I’m still experimenting myself!

Photo Viewers Galore, Part 5
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by Patrick G Horneker (phorneker)

While this article does not have to do specifically
with PCLinuxOS, it does tell about online gaming
using PCLinuxOS. The games I am talking about
require a Facebook account, and work with any
laptop, desktop, tablet, or smartphone, not just
systems that run on PCLinuxOS.
However, the Zynga games look pretty good under
PCLinuxOS, whether you use Firefox, Chromium, or
Opera. (These are the browsers supported by
Facebook.) Zynga’s support pages assume
everyone is running Windows, and the games
require Adobe Flash Player be installed. Fortunately,
Adobe Flash Player can be installed from Synaptic,
if you do not already have it installed. (You only
need the flash­player­plugin package to play the
games.)
Note: I have not tested Facebook with any of thelibswfdec packages.
Here is a partial
screenshot from
Farmville (right). For
privacy reasons, I
clipped the portion of
the screenshot that had
Farmville “friends” of
whom I play the game
with. Also, note the
comment I made in this
graphic.
As one could guess,
Farmville is a game

that somewhat simulates farming, in the sense that
you raise farm animals and grow crops, which you
can then sell, trade for fuel, or make all kinds of
items for use on your farm, as well as your
“neighbors” farms.
Among buildings that can be placed on a farm are
bakeries, horse barns, dairy farms, silos, nursery
barns (to raise calves and foals), chicken coops, pig
pens, sheep pens, and more. As of this writing, you
can now raise wildlife in sanctuaries.
As if that were not enough, there
are missions to fulfill, co­op jobs,
and some other rather silly tasks to
complete. In this screenshot, I have
planted a field of potatoes. As we
can see here, this is what a typical
farm in Farmville looks like. Do you
care to guess where my avatar is
on this screenshot?

Enough on Farmville. Frontierville and Pioneer Trail
(recently combined to function as one game) are
based on how people settled in the Old West
between the end of the American Civil War to the
Roaring Twenties.
On the next page, the image shows Frontierville as it
looks under PCLinuxOS. Here, you actually build a
settlement by clearing grass, wildflowers, rocks,
cacti, and skulls. You can chop down oak and pine
trees, plant new trees of various kinds, build cabins,

general stores, saloons, cabins, and other useful
structures.
While building your settlement, you will come across
many surprises, including the number of missions
that need to be completed (some of them have time
limits), bears that appear after chopping down large

Game Zone: FarmVille, FrontierVille,
Pioneer Trail & Other Zynga Games
Game Zone: FarmVille, FrontierVille,
Pioneer Trail & Other Zynga Games
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trees, foxes after feeding chickens and geese,
groundhogs after harvesting some crops (they don’t
just tell us the weather on February 2nd).
For most activities, one unit of energy is consumed
as we can see in this screenshot.
Also, when you start playing Frontierville, you are
single. You get to configure the look of your avatar.
You will receive messages from your fiancee, after
selected missions are completed. After you have
completed four missions where messages are
received, you will have built up your settlement to
the point where you craft fancy clothing, have a
cabin and a general store, grown a few crops, and
have raised some farm animals, your spouse will

arrive. You can
configure your spouse
the same way you
configure your avatar,
with the example
shown in this
screenshot.
There are many more
games Zynga has
available for
PCLinuxOS users
(and everyone else on
Facebook) to play. To
get the most out of
these games, you will
need to purchase
game cards from
select retailers such
as Best Buy, Target,
GameSpot, and CVS
Pharmacy. These

cards are redeemed at Zynga’s website.
There are two types of currency in each of the
games: coins and cash. You redeem cards to add
cash to your game. Depending on the game, you
may earn cash by completing certain levels of the
game. Coins are generally earned by playing the
game, but when it comes to the Markets in the
game, most items in the games are paid for with
cash. (You can see where Zynga makes its money.)
That withstanding, if you have not had a chance to
try out some of these games, and are on Facebook,
it is well worth the entertainment value, even for
PCLinuxOS users.

Game Zone: FarmVille, FrontierVille, Pioneer Trail & Other Zynga Games
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Screenshot ShowcaseScreenshot Showcase
1. All the contents of The PCLinuxOS Magazine are only for general

information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The NEW PCLinuxOS Magazine accepts no responsibility for
the content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Posted by longtom, August 27, 2011, running IceWM.



38

by Darrel Johnston (djohnston)
Linus Torvalds said in 1993: "If 386BSD had been
available when I started on Linux, Linux would
probably never have happened." NetBSD took its
roots from the original UCB (University of California
at Berkeley) 4.3BSD. via the Net/2 release, and from
386BSD. It was the second open source BSD
descendant to be formally released, after 386BSD.
The NetBSD project was founded by Chris
Demetriou, Theo de Raadt, Adam Glass and
Charles M. Hannum. In 1994, for disputed reasons,
Theo de Raadt left the project. He later founded a
new project, OpenBSD, from a forked version of
NetBSD 1.0 near the end of 1995. FreeBSD was
formed later with a focus on the i386 PC platform.
Frustration with the quality of patches in the wild and
the inability to get patches included in 386BSD led to
the founding of the NetBSD project in 1993.
NetBSD's original focus was quality and architecture
independence. Since then, in addition to the many
developments within the project, NetBSD has
imported changes from other sources, including
4.4BSD Lite. The NetBSD source code repository
was established on March 21, 1993, and the first
official release, NetBSD 0.8, was made in April,
1993. This was derived from 386BSD 0.1 plus the
version 0.2.2 unofficial patchkit, with several
programs from the Net/2 release missing from
386BSD re­integrated, along with various other
improvements. The first multi­platform release,
NetBSD 1.0, was made in October 1994. In 1998,
NetBSD 1.3 introduced the pkgsrc packages
collection.

As the project's motto ("Of course it runs NetBSD")
suggests, NetBSD has been ported to a large
number of 32­ and 64­bit architectures. These range
from VAX minicomputers to Pocket PC PDAs.
NetBSD supports 57 hardware platforms (across 15
different processor architectures). The kernel and
userland for these platforms are all built from a
central unified source­code tree managed by CVS.
Currently, the NetBSD kernel requires the presence
of an MMU (memory management unit) in any given
target architecture.
NetBSD's portability is aided by the use of hardware
abstraction layer interfaces for low­level hardware
access, such as bus input/output or DMA. Using this
portability layer, device drivers can be split into
"machine­independent" and "machine­dependent"
components. This allows a single driver to be easily
used on several platforms by hiding details of
exactly how the driver accesses the hardware, and
also reduces the amount of work needed to port it to
a new architecture.
This enables a driver for a specific PCI card to work
whether that card is in a PCI slot on an IA­32, Alpha,
PowerPC, SPARC, or other architecture with a PCI
bus. Also, a single driver for a specific device can
operate via several different buses, for example ISA,
PCI, PC card, etcetera.
Download the ISO for 386 architecture from here.
You can also download a torrent file from here. I’ll be
using VirtualBox for the installation, with 512MB of
RAM, 64MB of video RAM and an 8 GB dynamically
sized hard drive. This configuration is extremely
generous, as NetBSD doesn’t require anywhere
near these numbers to function well.

Starting with the first screen after booting from the
CD, select option 1.

We can select messages in English, French,
German, Polish or Spanish. I chose English.

I then chose US­English for the keyboard type. Next,
I chose to install NetBSD to hard drive.

Alternate OS: NetBSD, Part 1Alternate OS: NetBSD, Part 1

ftp://iso.netbsd.org/pub/NetBSD/iso/5.1/i386cd-5.1.iso
ftp://iso.netbsd.org/pub/NetBSD/iso/5.1/i386cd-5.1.iso.torrent
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Next, we are warned to backup any data on the hard
drive, and we are informed of the steps that will be
taken to install NetBSD to hard drive.

The installer found only one hard drive, the VBOX
HARDDISK. Next, we are offered the choices of a
full installation, a minimal installation or a custom

installation. I chose the custom installation, as it will
offer the choices of package installation. We
certainly want an X server. Shown below are the
X11 packages I chose.

Shown here are the overall packages sets I chose to
install.

Next, we are shown the disk geometry, consisting of
the BIOS disk number, the number of cylinders,
heads, sectors, and the disk size. We can either
accept the given disk geometry, or choose to edit
the disk’s parameters by hand. The values were
correct, and I accepted them. In the screen shown
below, we are offered the choice of editing the MBR
partition table or using the entire disk. I chose to edit
the MBR partition table. Using the entire disk will
result in no swap partition being created.

At this point, a primer on BSD disk labels would be
in order. In Linux terms, there can be many disk
partitions on any given hard drive. The first four can
be designated as primary partitions, but any number
higher than that must be designated as extended
partitions. If there are extended partitions, there can
only be as many as three primary partitions. The last
used primary partition becomes the container for all
the extended partitions. For example, if we have two
primary partitions, the third primary partition
becomes the container for all the extended
partitions. If we have three primary partitions, the

Alternate OS: NetBSD, Part 1



40

fourth primary partition becomes the container for all
the extended partitions. The extended partition
numbers begin with five, then count upward.
In BSD terminology, the four primary partitions are
called “slices”. There can only be four slices, and no
more. The slices are further subdivided into BSD
partitions. This will explain why we see four pre­
designated disk slots for use in the next screen. I
chose to create one slice consisting of the entire
hard drive which will hold all the NetBSD partitions
within it.

Next, we are asked whether to update the MBR to
the latest version of the NetBSD bootcode. Because
NetBSD will occupy the entire disk, I chose to install
the bootloader. The following screen explains the
BSD disklabel and gives an approximation of how
little disk space will actually be required. I chose to
set the sizes of the partitions (center top).

The traditional method is to use the first partition, or
a, for the root, and the second one, b, for the swap
area. We can then add up to twelve more partitions,
each with a different mount point. I chose to keep
things simple and allocated 7GB of space for the
root partition and 1 GB of space for the swap
partition. I chose FFSv2 (fast filesystem) as the
filesystem for the root partition. You will notice that
the third partition, although it is 0 MB in size, is
designated as “NetBSD partition”. The third partition,
c, is normally the same size as the entire slice. This
allows disk utilities, such as a bad block scanner, to
work on the entire slice. For that reason, the third
partition is usually unused as a mount point (top
right).
We are next asked to enter a name for the disk. I
entered NetBSD. In the next screen, we are told that
nothing has been written yet, and are asked whether
to proceed with the installation. In the screen below,
we are asked whether to install normal or serial
bootblocks. Normal bootblocks use the BIOS

console, usually a keyboard and monitor. Serial
bootblocks use one of the first four COM ports.

We are then informed that the first portion of the
procedure is complete. The system installer has
created the disk partitions, has created the file
systems and has checked the file systems for any

Alternate OS: NetBSD, Part 1
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errors. The next step is to install the filesets. We are
offered the choice of a progress bar, no indicators or
a verbose listing, which is the slowest option. I
chose the default option, a progress bar. We are
then asked to select a source for the filesets.

I chose the CD­ROM, then chose to continue the
process in the next screen. The filesets began

extracting from the CD­ROM and installing to the
hard disk.
After all filesets have been installed, another screen
appears, informing us that we are now able to boot
from the hard disk. We are also informed that some
essential things need to be configured. There is only
one option, “Hit enter to continue”. The first thing to
be configured is selection of the timezone.

We are then asked to choose a password cipher
method. The default is DES, but that method is
limited to a password length of only eight characters.
I chose MD5 (top right).

We are then asked whether to set a root password,
which I chose to do (right).

We are then asked to choose from three possible
shells. I chose the default, which is /bin/sh.
Installation is now complete. The screen message
recommends reading the afterboot manpage and
editing /etc/rc.conf (next page).

Alternate OS: NetBSD, Part 1
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We are then offered several more installation
choices, to reboot the computer, to enter a utility
menu or to exit the installation. I chose to exit. At the
resulting command prompt, I issued a shutdown
command.

Well, the system halted, but will reboot after a key is
pressed. At this point, we need to remove the CD
from the virtual machine.

I have rebooted and logged in as user root. At this
point, there are no other users on the system. There
is a boot error message about having an empty
hostname. That will need looking into.

Next month, we will look at creating a new user,
configuring the system, setting up our X GUI
environment and updating the system.

Alternate OS: NetBSD, Part 1

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

http://www.enkiconsulting.net
http://pclinuxos.com/?page_id=215
http://twitter.com/iluvpclinuxos
http://www.oneclicklinux.com
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Forum Foibles: Goodbye Windows, GoodbyeForum Foibles: Goodbye Windows, Goodbye

5 computers in the house. No MS products.Rudge
I've never had M$Windows in my home,ever. omskates
PCLinuxOS only. Neal
I run Linux only. jcolyng
I use PCLinuxOS on all the PC's in myhouse. Hootiegibbon
Three machines here. Linux only on all ofthem. jimwilk
PCLOS all the way Baby. AndrzejL
Only PCLinuxOS on my desktop.JohnW_57
All of my computers are Windows free. Mac
I practice what I have been preaching, NOWINDOWS! YouCanToo
pclinuxos, which i use exclusively ondesktop and laptop. jaydot
Been completely free of windows for about4 or 5 yrs now. kensum71

PCLinuxOS exclusively in our home. aguila
Have only one computer. Linux Inside.marcin82
My home computers are Linux. Meemaw
Everything (three desktops, two laptops and anetbook, currently running) are PCLOS. pags
All Linux here. Bald Brick
Nuttin' but Linux since Mar. '06. weirdwolf
My home is a windows­free zone. grnich
PCLinuxOS on all 5 puters. scoundrel
I have only run linux on my personal machinefor the last 3 years. arkanabar
Two laptops and a desktop running updatedPCLinuxOS. Archie
I am "free of Microsoft" ... don't need these%$##@*! bicol_willem
I have two desktops plus my laptop onPCLinuxOS. Padma
Strictly linux on 3. smileeb

There was a poll in the Sandbox
To see how the die was cast

It wasn't meant to chide
Or another OS lambaste

The users marked their ballots
And did it really fast

There was a clear cut choice
And it was easy to see the contrast

The outcome was predictable
And when all the votes were cast

You could hear the roar and shouting
Free! We're Free at Last

We thank blarney for his poll
For he's the one who asked
And we all are in agreement
PCLinuxOS is unsurpassed

FREE at LAST
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Forum Foibles: Goodbye Windows, Goodbye

OGG MP3

I'm telling Windows Goodbye
This old gal won't cry
A Linux OS takes me away from you
No words can tell how glad it makes me
Goodbye Windows again you lose and I win
I did it with ease 'cause you never did please
Now I'm free just as free as a breeze
Goodbye Windows Goodbye
Goodbye Windows Goodbye

I'm telling Windows Goodbye
This old gal won't cry
PCLOS takes me away from you
No words can tell how glad it makes me
Goodbye Windows again you lose and I win
With Linux I found everything so sound
So long Windows I'll see you around
Goodbye Windows Goodbye
Goodbye Windows Goodbye

Ta Ta

Ciao

Sayanora
Farewell

Arrivaderci
Hit the Road Jack

Vaya Con Dios
Fare thee well
Hasta la vista
Bon voyage

Shalom
Auf Wiedersehen

So long
Aloha

Adios
Au revoir

Tootles

Pip Pip

Get lost
Tallyhoo

GOODBYE WINDOWS, GOODBYE

http://www.pclosmag.com/html/Issues/201109/files/goodbyewindowsgoodbye.ogg
http://www.pclosmag.com/html/Issues/201109/files/goodbyewindowsgoodbye.mp3
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by Patrick G Horneker (phorneker)

This past month, I started redeveloping my website. I
spent the first half of July gathering up old
documents I had stored for many years, and
gathering up other resources that I want to use for
my website. At the time of this writing, I have a new
version of my website up and running, with fewer
graphics, and a better design. It is online at
http://horneker.com, and is PCLinuxOS­centric. As I
am developing new material for the website, I
present the next article in my WindowMaker series.
Besides the background already discussed
in an earlier issue, there are various options
you can configure from the WindowMaker
Configuration Manager (select from More
Applications ­> Configuration in the system
menu to launch).
Once the window appears on the screen,
select the Workspace tab. The following
should appear: ­­­­­­­­­­>
As we can see here, there are plenty of
available options (some of which in my
opinion should never be deactivated) for
configuration of your Workspace. We shall
go through each of these in order as
presented in the Configuration Manager.

Generate a new workspace
When you first run WindowMaker, four
Workspaces are created. By default, you can
cycle around each of the Workspaces using

the mouse wheel, or by clicking on the arrows on the
Clip. By default, when you cycle to the last
Workspace, selecting the next Workspace will cycle
back to the first Workspace.
Selecting this option will enable WindowMaker to
automatically create a new Workspace when you
select the next Workspace after you reach the last
Workspace.
Programmer’s Note: You should be able to
recognize that a linked list was used to implement
the list of Workspaces. Each element in the list is a
set of three links, namely a link to the previous

Workspace, a link to the next Workspace, and a
pointer to the data structure of which represents the
Workspace.

Icon Size
We discussed Icons in the past and their functions
within WindowMaker. As configured in the package
found in the PCLinuxOS repository, icons are 64 x
64 pixels in size. For most of us, this should suffice
for what we need to do with our PCLinuxOS­
powered systems (PC or Intel Mac).

For purposes of discussion here, Icon
refers to the WindowMaker Icon as
displayed on your Workspace, and icon
refers to the application icon assigned to
the WindowMaker icon.
Did you know you can resize all Icons on
your desktop?
Icons are always the same in height as it is
in width (which happens to be the
mathematical definition of a square) in
terms of pixels. WindowMaker supports
icon sizes from 24 through 96 in
increments of eight pixels, with 64 pixels
being the default for PCLinuxOS.
Be careful when resizing Icons. Application
icons do not resize when you change the
Icon size with the Configuration Manager. If
the application icon is larger than the Icon
size, the icon will be centered and cropped
to fit the Icon.

WindowMaker on PCLinuxOS: Workspace OptionsWindowMaker on PCLinuxOS: Workspace Options

http://horneker.com/


46

To Start or not To Start the Dock
This option when selected (by default) tells
WindowMaker to launch the Dock when a
WindowMaker session is started. Unless you have a
compelling reason for not wanting the Dock
displayed, this setting should be left selected.

Minimized Windows
When you minimize a window in WindowMaker (by
clicking on the upper left hand corner of most
windows), it shrinks down to a icon on the
Workspace. As configured with the PCLinuxOS
installation, the icon appears only on the workspace
where the application was running.
This makes sense as there is finite real estate on the
bottom of the screen, namely the width of your
display in pixels, and each application displays at
least one icon. Icons representing running
applications are displayed starting at the bottom left
hand corner of your Workspace, and expand as far
as the right hand corner of the Workspace. Because
of this, the default setting should not really be
changed.

Namespaces Displayed In Your Face
As you switch between Workspaces, the name of
the workspace is displayed in large type on the
direct center of your screen (hence the In Your Face
portion of the title of this paragraph).
With this setting, you can select for this to be
removed with the Not Visible setting, or you can
choose from the following positions on your screen:

Top of Screen (centered)
Bottom of Screen (centered)
Center of Screen (the PCLinuxOS default)
Top Left Corner
Top Right Corner (right justified)
Bottom Left Corner
Bottom Right Corner (right justified)

Smooth Background Edges
This applies a smooth edge to all backgrounds
assigned to all Workspaces if the images need to be
scaled to fit the physical screen.

Workspace Borders
One of the features of WindowMaker is to be able to
move Windows to adjacent Workspaces by dragging
the window to the adjacent workspace. For this to
happen, Workspace Borders need to be active.
Workspace Borders are located at the edges of
every Workspace.
The Position of Workspace Border option selects
which edges are active as borders. You can select
the left and right edges of the screen, the top and
bottom edges of the screen, or you can select all
edges of the screen.

Window Attraction
It is possible to move a group of windows on the
Workspace at once by dragging a window and
literally collecting other windows in the group, similar

to collecting metal objects with a magnet. Selecting
the Attract a Window... option enables this feature.

Automatically Move Windows to Adjacent
Workspaces
The Automatically move windows to next/prev
workspace... function, when selected allows you to
move windows on your Workspace to the
neighboring Workspace.

To Show or Not To Show Minimized Applications
As stated earlier about minimizing applications, the
application window sizes down to an Icon. There is
an option to not show these Icons on your desktop.
By default, minimized applications are displayed as
Icons. There should be no real reason to change this
setting.

There are Ants on My Icons
This gimmick animates minimized applications that
are selected on your Workspace, but are not
showing as application windows. The animation
looks like ants crawling on the edges of the Icon.

The Other Workspace Selector Option
As configured for PCLinuxOS, selecting the next
Workspace when you are at the last workspace will
automatically jump you to the first workspace. This
option can be disabled by deselecting this option.

WindowMaker on PCLinuxOS: Workspace Options
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To Start or not to Start the Clip
This option when selected (by default) tells
WindowMaker to launch the Clip when a
WindowMaker session is started. Unless you have a
compelling reason for not wanting the Clip
displayed, this setting should be left selected.
WindowMaker Can Arrange That
This option allows WindowMaker to automatically
arrange minimized windows at the bottom of the
screen. Deselecting this option will create chaos
when it comes to which icons belong to which
applications.
Border Size Matters
Workspace Borders have adjustable widths (from all
edges of the screen) from zero to five pixels. Of
course, setting a width of zero disables the
Workspace Borders feature.
Pick A Corner
As configured for PCLinuxOS, minimized windows
build from the lower left hand corner. Not only can
you change the corner where the Icons are placed,
you can change the direction in which minimized
windows are built. You can choose from the
following:
Horizontal from Top Left Corner
Vertical from Top Left Corner
Horizontal from Top Right Corner
Vertical from Top Right Corner
Horizontal from Bottom Left Corner

(the PCLinuxOS default)

Vertical from Bottom Left Corner
Horizontal from Bottom Right Corner
Vertical from Bottom Right Corner

Next time, I shall show you the Window Handling
options available for WindowMaker.

WindowMaker on PCLinuxOS: Workspace Options

Screenshot ShowcaseScreenshot Showcase

Posted by BubbaBlues, August 18, 2011, running KDE4.
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By Juan Saravia (Mechatotoro)

As it is well known, many modern languages are
written with Roman letters. However, if you are a
user who must type reports or create presentations
in a language that employs a different writing
system, you do not have to pay a lot of money to be
able to produce such documents. Whether that
language is Japanese, Chinese, Thai, Korean or
Hebrew, PCLinuxOS has your back covered. Yes, in
some simple steps, you can enable your computer
to handle a wide variety of writing systems thanks to
SCIM, an input method editor (IME) that interprets
what you type on your keyboard and converts it to
the language of your choice.

Installing SCIM in PCLinuxOS 2011.6 KDE
The installation process of SCIM does not require
highly­advanced skills. If you can use Synaptic and
a text editor like KWrite, you are good to go. First,
you launch Synaptic to retrieve the required
packages and their dependencies from the
PCLinuxOS repository. This is the list:
1. SCIM(the input method editor)
2. SCIM­bridge
3. SCIM­bridge­gtk
4. SCIM­bridge­qt4
5. SCIM­input­pad
6. SCIM­m17n
7. SCIM­tables
8. UIM (a multilingual library)
9. SCIM­UIM (a wrapper)
10. Fonts (fonts­ttf­japanese, fonts­ttf­korean,

depending on the language that you need)

*Note: If you need to work with Japanese, you will
also want these packages:
1. Anthy (another Japanese IME)
2. SCIM­anthy (a wrapper)
3. Canna (one more Japanese IME)
4. SCIM­Canna (a wrapper for Canna)
5. SCIM­tables­ja (requiredforJapanese)
Once you have downloaded and installed all the
packages, you must add some lines to a system file
called i18n. To find it and edit it, click on the menu
and go to More applications> Terminals>Konsole.
When you see the prompt, type the command su
and enter root’s password because you need root
privileges to modify the file.
You must now enter the command cd etc/sysconfig
and hit enter to go to the directory sysconfig, where
i18n is located.
Now, you must edit the file. To do so, type kwrite in
the prompt and hit enter to fire up the editing
application. You will see something like this:

You need to open i18n, so click the “Open” button.
The contents of the directory will display and you will
be able to see the file there.

Click on it to open it. All you have to do is append
these four lines to the end of the text that you see:
XMODIFIERS=@im=SCIM
GTK_IM_MODULE=scim­bridge
QT_IM_MODULE=xim
XIM_PROGRAM="scim ­d"
Simply copy/paste them so that everything looks like
this:

Type In Multiple Languages With SCIMType In Multiple Languages With SCIM
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Save the file. With that action, the installation
process is finished. Log out and back in to activate
SCIM. You can configure the input editor by going to
Menu>More applications > Configuration > SCIM
Input Method Setup.

Configuring SCIM
You have several options on the left panel to make
SCIM behave according to your needs.

Front End>Global Setup lets you select your type
of keyboard and assign shortcuts.
In IMEngine, you can check the boxes to select as
many languages as you need.

Panel, on the other
hand, lets you
configure the
behavior of the
language toolbar. It
is a good idea to
keep the default
option (“on
demand”). This
way, you will only
see the IME when
you want to work
with it.
If everything went
as expected, when
you open Writer in
Libre Office, you
will be able to
toggle the SCIM
toolbar on and off
by pressing CTRL
+ SPACE. You can
move it, so place it
where it does not
get in your way. An
advisable place to

keep it is above the system tray since it will appear
there every time you toggle it on.
As you type, the letters that you input will
automatically convert to the writing system of your
choice. When you are done, you can use the

shortcut CTRL+ SPACE or choose “English
keyboard” to toggle the IME toolbar off.
Not only does SCIM transform your keystrokes when
you work with Writer, but it will also perform its
magic in Impress, Spreadsheet, and even as you
browse the Web with Firefox, which is certainly
convenient. Therefore, do not despair, international
users of PCLinuxOS with SCIM, you can recover the
joy of typing in many other languages easily and free
of charge!

Type In Multiple Languages With SCIM

http://www.linfx.com
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It's easier than E=mc2
It's elemental

It's light years ahead
It's a wise choice

It's Radically Simple
It's ... Posted by Ramchu, August 1, 2011, running KDE4.

Answers to Mark Szorady's Double Take:
(1) Fish fin different; (2) Mouth different; (3) Ear bud
missing; (4) Fish moved upward; (5) Rock missing; (6)
Sea plant different; (7) Word balloon different

http://www.pclinuxos.com
http://cozmodesigns.co.uk/PCLKids/index.php


51

by Gary L. Ratliff Sr. (eronstuc)

This is the first time in this series in which we have
encountered a markup language. Perhaps the most
well known markup language is HTML which is used
to markup almost all the pages of the web. This
stands for Hyper Text Markup Language while XML
stands for Extensible Markup Language. This is a
meta language which is used to define other markup
languages.
To research this, article I found the book which my
wife had given me many years ago, called: XML
Bible, by Elliote Rusty Harold, published by IDG
Books Worldwide in 1999. Then, I wrote the author
to ask about a comment he had made concerning
the lack of support in Linux at that time. He wrote
back to let me know that this book was about four
issues behind and that I should obtain and use XML
1.01 Bible.
As I read the text, it became obvious that much of
the material was dated. Now consider that if you
have been using Linux for a long time, what was the
difference in the Linux you use today, and that of
1999 (perhaps at that time I was using Mandrake
7.0). It lacked many features we take for granted in
today's versions, including the ability to produce
sound. To do that I had to purchase a separate
system from OSL which allowed me to hear sounds
on the system. Nor were there any productivity
suites such as OpenOffice at the early days.
The most useful feature of this volume is the
example markup files provided by the included CD­
Rom disc. This includes the text of the Old and New
Testaments, the Koran, the book of Mormon, as well

as the complete plays of Shakespeare (this one in
full XML Markup language).
Here we see a portion of the play Hamlet, in XML
markup.

Unlike HTML which has fixed tags, XML
allows you to define your own. Then, their
behavior is defined in style sheets and
DTDs (Document Type Definitions). There
is a language which has HTML in XML
aptly named XHTML. This language
defines 28 different modules, 26 of which
must be included to even begin the
simplest HTML document. XML is thus a

very complicated system to learn. You may choose
the path I did, and pursue reading a 1200 page
tome, or you may more easily rely of the references
and tutorials provided on the Internet to continue
your learning of the uses and correct expression of
XML.

When I first started this series I called it:
An Alphabet of Computer Languages, the
object being to provide examples of
twenty­six languages one for each letter of
the alphabet. Now I have mentioned that
XML is used to create other markup
languages. That fact is brought out by the
Wikipedia article, which reveals that I
might be able to just as easily write a
series as An Alphabet of XML Markup
Languages.

Computer Languages from A-Z: XMLComputer Languages from A-Z: XML
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As you can see, the index has spaces for every
letter of the alphabet. The article just lists the
purpose of the example languages. There are
several listed under each letter in almost all cases.
Currently, XML is in version 1.1. However, a version
2.0 has been proposed. Actually, version 1.0 seems
to be the more widely used at this time. You need
learn to use the DTD and style sheet (either CSS or
CSS2.0 of XSL, an XML based style sheet, to show
the proper display of the material).

The above screen shot shows how the article on
XML found in the Wikipedia introduces the material
on using the DTD of XML.

For a tutorial to
XML, I
recommend
that provided
by W3Schools,
from which the
following
example page
is provided:
­­­­­­­>

As you can see, there are several
lessons involved. After spending
some time in learning the material,
you may learn how to use the XML

tool to your own purpose.
Next time, we will discuss the language Yorick. I
know it has been quite some time since the last

article. Since then, I decided to visit the Emergency
Room of the local hospital to learn why I was in so
much pain. It seems that the brand of arthritis I have
makes just moving about rather painful. This does
not inspire sitting up and writing. So, as this article
has been written, you should know that I am feeling
much better. Also there are now only two articles left
till the end of the series.

Computer Languages from A­Z: XML
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Posted by LKJ, August 21, 2011, running Fluxbox.

Posted by Archie, August 10, 2011, running KDE4. Posted by konaexpress August 28, 2011, running LXDE.

Posted by ltelmo August 15, 2011, running LXDE.

More Screenshot ShowcaseMore Screenshot Showcase






